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Message from the President:

I would like to thank the IAPP Membership 
for the honor of being elected as president 
of our wonderful association

  My 5-year involvement with this group-
--first as a member, then board member, 
then treasurer---has inspired my shooting, 
stitching and exhibition work.  

I would like to outline a brief set of goals 
to provide our membership with years of 
inspiration, techniques and opportunities 
to make the panoramic experience more 
enjoyable and rewarding. 

Technology is progressing at an increasing 
rate, and this provides panoramic photogra-
phers with many new hardware and software 
and web-based tools, at low cost and ease of 
use.  We would like to expand applications 
and markets, as well as open up additional op-
portunities for public / private partnerships.

As our first goal, we are in the process of 
developing a new “IAPP Panoramic Lab” 
which will ultimately include a historical 
overview of the presentation and promotion 
of panoramic images.  Currently, we have 
plans to solicit and showcase members’ 
panoramic images printed on various media 
as examples of commercial, decorative, textile 
and fine art applications (bookmarks, scarves, 
murals, curtains, clothing, rugs, etc). 

In addition, the lab (which will be open for 
public viewing) will contain a 360-degree 
Cyclorama Tent to view our 360-and 

180-degree images in large scale using 6 video 
projectors.  This will allow our members to 
submit their own images electronically to be 
projected up to 35 ft wide.  

This approach is great for several reasons, 
one being that it is faster and cheaper to 
project than it is to print images at theses 
large-scale sizes, as well as inspiring future 
series of large panoramic photos such as 
capturing immersive images for historical/
journalist content, commercial applications, 
or industrial training backgrounds.

Finally, this is an invitation to our members 
and outside players---be they institutions, 
trade organizations or vendor companies---
to call or email me and/or one of our board 
members with suggestions of new ideas (and 
possible outside sponsorships) for current or 
future projects/experimentation.  We hope to 
hear from you in the near future and welcome 
any and all ideas.

Sincerely,

Francis 
Gardino
President, IAPP
President@panoramicassociation.org

Editor’s Notes:

In this issue we review our successful 
conference in the Chicago area.  A big 
thanks to Tom Sheckels for planning such 

a great conference along with some local leg 

work by Elliot Miller.  It will give a taste of the 
sights that were enjoyed by all who attended.  

Our hope is that this will encourage more 
members to attend our next conference 
scheduled for April 2019 in the Boston, MA 
area. Our host in Boston will be our current 
President, Francis Gardino.  From what we 
have heard so far, it is going to be a wonderful 
conference. Watch our Facebook page and 
check our website for upcoming details.

I was recently asked what happened to the 
gallery edition of PANORAMA?  Well, it has 
not gone away. However, for us to publish 
that edition we need content from you our 
members.  That means your images.  We had 
so few members submit their works last year 
that it did not justify the printing and postage 
costs.  So, it was decided that the images 
we did receive would be combined with the 
conference issue and have a mini gallery 
section.  Our next planned gallery edition 
will be published in December 2018.  We will 
be accepting images now through December 
1st, 2018.  Please size them at 12 inches (on 
the long side) at 300ppi and RGB.  You may 
submit up to four images.  All images should 
be sent to: iapppanoramajournal@gmail.com.  

As you acquire new images that you would 
like published please send them to us on a 
regular basis so that we will always have an 
inventory to pull from for future issues. 
Thank you for being loyal members of IAPP 
and we hope you will enjoy this issue.

David Kutz
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On October 15th-18th, 2017, members 
of the IAPP gathered in Chicago for their 
conference.  It was a time for meeting 
up with old friends, making new friends 
and discussing all 
things panoramic.  New 
equipment, new techniques 
and trends as well as what to 
do with legacy items and the 
possibilities for a panoramic 
museum in the future.  

President Tom Sheckels 
opened the festivities with 
the schedule for the week 
which included a scenic 
architectural boat tour of 
the city.  A special visit to 
Panoramic Images and a 
trip to the observation deck 
at the John Hancock tower. 
Sunday evening and 
Monday morning time were 
spent on presentations. 
Lifetime member David 
Orbock gave a presentation on his latest trip 
to Cuba.  Some panoramic and many general 
interest shots of everyday life in areas beyond 
where the tourists venture.  Such as the local 
peoples’ cleanup efforts on the island after 
the hurricanes and shots of how the residents 
live.  David also demonstrated his new Cuban 
camera that he acquired made from recycled 
cans.  

Paul Speaker presented a learning tutorial 
on HDR Panoramas De-Mystified (see the 
accompanying article in this issue).  Paul’s 
step by step approach should help anyone 
to produce their HDR images without any 
frustration.  Paul also presented a way to filter 
out and remove dust spots from images and 
how to work with luminosity masks.

Mark Segal presented some his panoramic 
aerial work.  He discussed his approach to a 
project from a visual and safety standpoint.  
Mark started out shooting aerials with 
Roundshot film cameras hanging below full-
size helicopters.  Later moving into digital 
cameras and model helicopters to capture 
aerials.  He discussed his preference for using 
that type of helicopter as opposed to using 

multi-prop drones in his work from a safety 
standpoint.  There was also discussion about 
all the new FAA regulations now imposed on 
aerial drone photographers and how to follow 
the rules and who should be contacted before 
proceeding to shoot in an area.

Jook Leung gave a presentation on how he 
shoots and designs his 
virtual panoramas to 
move and tell a story.  His 
panoramas are a delight 
to watch as he guides the 
viewer through a path that 
shows the whole panorama 
as a mini movie.  Jook also 
showed the group some of 
the drone aerials that he 
has started to produce.

The group headed 
downtown in the afternoon 
to shoot some panos and 
take the architectural boat 
tour.  Due to the heavy 
rains the week before, we 
had to wait for the water 
level of the river to drop 
so the tour boat could 

navigate under the many bridges in the 
downtown area.  Thankfully after a three hour 
delay we were able to depart, take the tour and 
treated to a wonderful sunset panorama of the 
city skyline from the waters of Lake Michigan.  
After departing from the boat, we moved on 
to Dick’s Last Resort for dinner and much 
liquid merriment with some occasional insults 
from our cast of waiters. 

IAPP Takes on Chicago
By David Kutz
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Among our other speakers that week, Tom 
Sheckels presented his panoramas from a 
recent trip to Cuba.  Showing some of the 
bright colors and great old cars from the 50’s 
and 60’s that still are running in that country.  
Also, Tom was able to capture some of the life 
of the locals including a dance festival.  Tom 
then presented some panoramic shots and 
photos from his latest trip to the Azores off 
the coast of Portugal.

New member David Berg presented an 
interesting program on the Lakota Uprising 
of 1862 in Minnesota.  By tracking down 
the calendar dates of the events David went 
to each location on the specific day that 
each event took place and shot a series of 
panoramas at those locations.

Fran Gardino showed some of his latest 
abstract panoramic shots and vertical panos.  
Discussing the way, he looks at shooting and 

presenting his images.  Fran also discussed 
his plans for the Frano-vision tent projection 
system that he was just starting to develop 
with his son.

The group then departed for another trip to 
downtown Chicago to meet up with Nick 
Ulivieri at the observation deck of the John 
Hancock tower.  Nick demonstrated some of 
the tricks he uses to shoot from high vantage 
points and through glass windows when 
necessary.  Members then took turns shooting 
dusk and night shots of the city from the 
observation deck.

Wednesday morning Matt Lombardo 
from Pixel Mint visited us to talk about his 
company’s scanning, printing and mounting 
services.  Matt gave us insights on what types 
of scanners give the best image qualities.  How 
he sets up his workflow and what corrections 
he uses to clean up a client’s image.

Fran Stetina gave us a taste of a four-year 
project he continues to work on.  He is 
creating his illustrations of Dante’s Devine 
Comedy by shooting images in Luray 
Caverns.  Fran then takes those HDR images 
and pushes them to extreme colors in 
Photoshop to come up with his final artworks.

The afternoon was spent on the business 
meeting.  President Tom Sheckels thanked 
everyone for coming to the conference.  He 
then introduced the new President Fran 
Gardino and gave the results of the election 
for officers.  Fran then took over the meeting 
and outlined the projects that he wished to see 
accomplished over the next 18 months.

In the evening the group gathered for the 
traditional banquet, to say goodbyes and the 
awards ceremony for the photo competition.  
The winners included Elliot Miller, Tom 
Sheckels and David Berg.

Chicago Bean by Fran Gardino
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Tom Sheckels

The Presenters
Photos by David Kutz

Mark Segal

Jook Leung

Fran Gardino Matt Lombardo

Nick Ulivieri

Paul Speaker

Dave Orbock
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Fran Stetina

Dave Berg Atop the John Hancock Tower with Mark Segal and Paul Speaker

President and Past-President: Fran Gardino and Tom Sheckels
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Conference Activities
Photos by David Kutz

Tom Sheckels, Tom Bleich, Steve Delroy, Kay Larkin

Jook Leung and Tom Sheckels

Jook Leung

Nancy Speaker
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Glenn Cope

David Berg, Tom Sheckels 
and Marilyn Berg

Kay Larkin

Dave Orbock

Steve Delroy

View of the Observation Deck, John Hancock Building. By Fran Gardino.
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Conference Print 
Competition
Photos by David Kutz

Architectural Winner: David Berg

Print Winner: Elliot Miller
Kentucky Derby



11

Overall Winner: David Berg
Ferris Wheel

Landscape Winner: Elliot Miller
Desert

Print Winner - Cityscape: 
Tom Sheckels

Las Vegas

A portion of the competition display.
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Open House and Tour of
Panoramic Images
By David Kutz

Doug Segal welcoming conference attendees.

While in Skokie, IL 
we were invited 
by Doug Segal, 

President of Panoramic 
Images to tour and have 
lunch at the open house of 
the remodeled Panoramic 
Images.  The company 
has been a leader in the 
panoramic stock photography 
world and has acquired much 
of the remaining collection 
of panoramic photographer 
Fred Schutz. Doug and his 

staff are currently scanning, cataloging and 
preserving Fred’s body of work that included 
many historical large group shots in the 
Washington, DC area and different important 
panoramic documentation in Europe after 
World War I.

After lunch, Doug Segal gave us an overview 
of some of the changes in the stock 
photography business and how Panoramic 
Images is directing their resources and 
efforts to best represent their contributing 
photographers, researching and servicing 
clients requests as well as preserving 
collections of panoramic works.  Michelle 
Novak, Pi’s Director of Photography navigated 
the group through their new electronic 
catalog system and showed examples of how 
to keyword search to find particular subjects.

Following the presentations, it was time 
for touring the facility.  The gallery area, 
preservation library and cataloging stations. 
In the scanning room they are equipped 
with Hasselblad scanners as well as a new 
Phase One capture station for larger Cirkcut 
negatives and prints.

Virginia Zirkle at 
scanning station.

Group photo with 
IAPP conference 

attendees and 
staff of Panoramic 

Images.

Michelle Novak 
giving scanning 
demonstration.

Doug Segal giving 
image processing 
demonstration.
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Chicagoland Cityscapes

Above: Navy Pier at Sunset by David Kutz.
Top Right: Chicago Cityscape by David Kutz.
Middle Right: Evening Skyline by Kay Larkin.
Below: Chicago Night Skyline by Fran Gardino.
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HDR Panoramas 
De-Mystified
By Paul Speaker
M.Photog., M. Artist Cr., CPP

High Dynamic Range (HDR) is an 
evolving art form which attempts 
to capture and render the full 

luminosity range, as seen by the eye. It 
utilizes hardware, software, and technique to 
achieve its goal of rendering detail in both the 
brightest highlights and the deepest shadows. 
It is useful in difficult, high contrast lighting 

situations. If judiciously used, the use of 
HDR can expand your opportunities to make 
successful panoramas in situations you might 
otherwise pass by.

For example, shooting a pano from inside 
Indian Cave, located in the Coulee Corridor, 
south of Grand Coulee Dam, in eastern 
Washington, presents just such a difficult 
lighting situation: When the camera recorded 
the scene (fig-1), properly exposed for the 
full daylight outside the cave, the inside of the 
cave lost detail, being almost totally blocked 
up. Conversely, when the camera was exposed 

for the inside of the cave, the outside scene 
became washed out (fig-2). The white clouds 
needed an exposure of 1/250 @ f16 at ISO 
200 (the Sunny 16 Rule). Due to the thin high 
cloud cover, the overall landscape needed 
1/125 @ f16. The shadow at the edge of the 
cave entrance needed an exposure of 1/15 
@ f16, a loss of 5 stops. Finally, to properly 
expose the rock walls inside the cave, near 
where the camera was located, entailed 
another 5 stop loss, to 2 sec @ f16 at ISO 200. 
(fig-3) While most camera sensors are capable 
of capturing between 5 and 6 stops with a 
single exposure, there are very few capable of 

Unless 
noted, all 
“figures” in 
this article 
are identi-
fied by a yel-
low number 
within the 
image.
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covering the entire 10 stop range represented 
by this situation. HDR to the rescue!!!

Hardware - What you need to know before 
you attempt your first HDR panorama: You 
can use any digital camera having an Auto 
Bracketing function. You will need to decide 
how many images per bracket you wish. Usu-
ally, most photographers select either 3 or 5, 
although some cameras allow more exposures. 
You will also need to set the exposure incre-
ment between exposures. This can range from 
1/3 stop up to 3 stops, depending on the cam-
era being used. Check your camera manual to 
learn how to set the Auto Bracketing (AEB) 
function. The more images you have in your 
bracket, the smoother the rendered HDR im-
age will appear. I highly recommend that you 
change the order of the AEB to run from the 
darkest to lightest exposure—this makes find-
ing the sequences easier. For most cameras 
the default setting is Normal, Under, Over. 
While it is possible to create handheld HDR 
panoramas, it is much easier to stitch the im-
ages together if the camera is mounted on a 
sturdy tripod (with a pano head, if you have 
one). The use of a cable release, or your cam-
era’s self timer, is recommended to minimize 
camera motion, particularly on the longer 
exposures. I recommend setting the camera 
to expose in High Speed Continuous mode, 
rather than Single Shot, particularly if the 
subject has moving elements. Use your fastest 
memory cards, so you don’t get hung up by a 
slow transfer of data from your camera’s buffer 
to your card. To minimize depth of field shifts, 
shoot in Aperture Priority Mode, or go full 
Manual. Remember, shutter speed should be 

your only variable. Try Spot Metering—HDR 
is all about getting one point exposed per-
fectly, then bracketing around that. Set your 
camera to shoot Raw, or Raw plus jpg, for 
maximum post-
processing capabil-
ity. Shoot for the 
‘basement’— the 
darkest frame 
should have little 
or no detail, as seen 
on the back of your 
camera by your 
eye. Finally, shoot 
with as low an ISO 
as practicable, in 
order to reduce 
noise.

So, your camera is 

now set to capture an HDR panorama. What 
subjects look good? Try Old Stuff (fig-4). 
Overhung or Shadowed Areas (fig-5). Texture 
and/or Machinery (fig-6).
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Also worth exploring: dimly lit Interiors, Ur-
ban Exploration/Street Scenes, Sci-Fi, Interior 
Rooms, Angry Men (!!), Twilight Scenes Inside/
Outside Windows.

Software - There are many software packages 
that accommodate your bracketed sets of HDR 
images. All of us should have Adobe Photoshop 
installed on our computers. To access the HDR 
function in Photoshop CS6 through CC2018, 
go to File>Automate>Merge to HDR Pro. This 
is also accessible through Bridge or Lightroom. 
Be aware the first time you access this function, 
you’ll find yourself in a 32-bit environment, and 
Photoshop will present very few options that 
work. The trick is to drop the bit depth down to 
16 or 8 bit, (Image>Mode>16 or 8) where you 
will have all of Photoshop’s tools available to 
you. You should also have the Google/NIK HDR 
Efex Pro applet installed, if for no other reason 
than because it’s free!! Go to  http://www.google.
com/nikcollection to get your free copy asap. It 
will load into the filter menu of Photoshop. My 
program of choice to render my HDR cap-

tures is Photomatix, by HDRSoft,  http://www.
hdrsoft.com. This creates the tif files that are 
then brought into the stitching program of your 
choice. When it comes to actually merging the 
HDR files, I have PT Gui as a backup, but prefer 
Photoshop for most horizontal images. Go to 
File>Automate>Photomerge to start the pro-
cess. At the bottom of the Photomerge screen, 
check all the boxes except Content Aware Fill 
Transparent Areas—there are easier ways to 
accomplish what this attempts to do. Also, 
Photoshop will usually use a Cylindrical layout, 
so checking the Auto button, top left, should 
work in most cases where you have 4 or more 
HDR image sets. Each HDR program is capable 
of producing different results, depending on 
your vision for the scene (fig-7). There are many 
other HDR programs, too numerous to mention 
in this short overview. In fact, entire books have 
been written about the HDR programs that are 
available, and new ones are being developed all 
the time. One of the newest is Aurora HDR by 
MacPhun, which is now both Mac and Win-
dows compatible, and is a recommendation by 

Trey Ratcliff of stuck-in-customs fame.

Technique - Regardless of the software used 
to render your HDR files, additional post-
processing is required. Like any regular image, 
there should be no visible dust spots. I highly 
recommend creating two dust-catcher curves 
(fig-8) to use with a Curves Adjustment Layer 
on your stitched image. Dust spots are most 
noticeable in areas of uniform color, e.g. blue 
skies. (fig-9) Dust spots are usually a round, 
soft edged area of uniform density that will 
pop out when an extreme curve is applied (the 
dust-catcher curves, for example), thus isolating 
that density, making it easy to see. (fig-10) Use 
the Spot Healing Brush set to a size slightly 
larger than the dust spots, with Content Aware 
selected on the top menu bar. A single swipe 
across the dust spot should eliminate it entirely. 
Always run both dust-catcher curves to ensure 
you’ve removed all the dust spots. (fig-11) This 
is much faster than using Lightroom’s dust spot 
correction process, which requires LR match 
the selected area with a clean area of like 

3 Figure 7
5 Figure 8
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density and coloration.

After dust spotting is complete, 
continue to post-process your 
HDR pano in your usual manner, 
using the adjustment layers avail-
able to you in Photoshop, includ-
ing Curves or Levels, Hue and 
Saturation, etc. Further refine 
your image using filters, includ-
ing Photoshop filters, NIK filters, 
especially Viveza and Color Efex 
Pro. Topaz Labs has a series of 
filters that work well, including 
their Adjust, Detail, Simplify, or 
Impressions aplets. 

Sometimes, if you’re not careful, 
HDR techniques can produce 
some rather funky skies (fig-
12). One way to correct this is 
to blend in one of the original 
capture images that is clean. In 
this case, the Normal image was 
aligned above the HDR image, 

then masked, (fig-13) so the sky of the Normal 
image is visible, but the good HDR foreground 
is revealed underneath (fig-14). 

Another problem, often encountered when 
working with HDR images, is haloing at con-
trast edges, most often seen at sky/land or sky/
building interfaces (fig-15). Use the Clone 
Stamp tool set to Darken mode, a small, soft 
brush, and sample near the lighter halo to paint 
in the correct sky and density. (fig-16) In Dark-
en mode, the cloning will not go darker than the 
source. Change your sample point frequently to 
avoid any semblance of clone tracking (fig-17).

Finally, add an appropriate vignette, if desired, 
and save your layered psd file (so you can re-
turn to make further adjustments, later), then, 
flatten, and save again in your normal format. 
Later, you can crop and resize, as necessary, for 
specific applications of your image as the need 
arises. Congratulations!! You’ve just worked an 
HDR panorama successfully (see San Diego 
Skyline at Dusk below)!!
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In the fall of 1862 the Lakota Indians in 
southwestern Minnesota attempted to retake 
their tribal lands that they had given up 

in an earlier treaty with the US.  This ‘Lakota 
Uprising’ lasted approximately five months, 
culminating in the defeat and removal of the 
Lakota Indians from the state of Minnesota 
in the spring of 1863.  The state of Minnesota 
organized a remembrance of the events in 
2012.  Anticipating this sesquicentennial event, 
I developed a personal photographic project 
wherein I would visit some two dozen of the 
known conflict sites in 2011 and produce a 
360-degree panoramic image of the sites. I 
determined to take the panoramic photograph 

The Lakota Uprising of 1862
By David Berg

on the exact date (and time, when known) that 
the event occurred in 1862/63.  The weather 
cooperated, and all the panoramic photographs 
turned out perfectly.  The project was reviewed 
by the Minnesota Historical Society, but it 
was deemed incompatible with their website 
design.  My plan is to eventually produce a 
printed volume of the photographs as a personal 
reminder of the project.  
 
The following photos are representative of the 
project.
 
1:  Site of the ferry crossing Lakota Indian am-
bush on US Army soldiers

2:  Lower Sioux Agency warehouse interior – 
HDR

3:  Lower Sioux Agency warehouse – first attack 
by the Lakota Indians

4:  Crow Creek, SD, on the Missouri River – 
drop off site of the Lakota Indians after removal 
from Minnesota

5:  Marker just north of Hutchinson, Minnesota, 
at the site of the murder of Chief Little Crow, 
who led the Lakota Uprising

6:  Ft. Thompson SD, Dakota Indian Memorial
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2017 EPSON Gold Award Winners

Pamela Jennings, Run Out
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Randall Zumwalt, 
Honor Heights, 
Muskogee

Katherine McInroy, 
The Blue Room
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Rodney Campbell

Randall Zumwalt, Oklahoma City National Memorial
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Jeff Grant, Landmannalaugar
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Randall Zumwalt, Cherokee Nation Courthouse
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Julio Castro, Prado - The Best Lighthouse in the World



Hatches Harbor Sunset by Peter Schaible


